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ABSTRACT 

At the request of U.S. Army Dugway Proving Ground's Installation Restoration Program, the U.S. 
Army Engineer Research and Development Center's Cold Regions Research and Engineering Lab devel- 
oped a Geographic Information System (GIS) for management and analysis of environmental restoration 
data. The GIS software can be used to compare and analyze datasets of diverse types, e.g., orthophotos, 
contaminant information stored in a database, and geospatial datalayers such as sample locations, roads, 
and buildings. Powerful chemical query capabilities allow the user to search for analytical results either 
basewide or at a particular site. Users can also query one or multiple contaminants by a specific detection 
threshold level, or return all sample results regardless of detection level. Query results can then be mapped 
to the screen to highlight clusters and/or possible contamination trends, or exported to a spreadsheet 
program. Hard-copy maps can also be printed from the software. 

DISCLAIMER: The contents of this report are not to be used for advertising, publication, or promotional purposes. 
Citation of trade names does not constitute an ofificial endorsement or approval of the use of such commercial products. 
All product names and trademarks cited are the property of their respective owners. The findings of this report are not to 
be construed as an official Department of the Army position unless so designated by other aufliorized documents. 
DESTROY THIS REPORT WHEN IT IS NO LONGER NEEDED. DO NOT RETURN TO THE ORIGINATOR. 
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CONVERSION FACTORS, NON-SI TO 
SI UNITS OF MEASUREMENT 

Non-SI units of measurement used in this report can be converted to SI units 
as follows: 

Multiply By To obtain 

acres 4,046.873 square meters 

miles (U.S. statute) 1.609347 kilometers 
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Dugway Proving Ground 
Installation Restoration Program GIS 

Software Documentation and Training IMaterials 

PAUL T. CEDFELDT, JOEL D. SCHLAGEL, AND DAVID C. FINNEGAN 

1 DPG INSTAL!_ATION RESTORATION PROGRAIVl GIS 
(DPG-GIS) 

At the request of Dugway Proving Ground's Installation Restoration 
Program, the U.S. Army Engineer Research and Development Center's Cold 
Regions Research and Engineering Laboratory (ERDC-CRREL) has developed 
a Geographic Information System (GIS) for management and analysis of envi- 
ronmental remediation efforts. Dugway Proving Ground (DPG) is the nation's 
primary chemical and biological defense testing facility and is located on 
798,855 acres in the Great Salt Lake Desert, approximately 85 miles southwest 
of Salt Lake City, Utah. Surrounded on three sides by mountain ranges, the 
proving ground's terrain varies from level salt flats to scattered sand dunes 
and rugged mountains. 

DPG was activated on March 1,1942. Shortly thereafter, military weapons 
testing commenced under the Technical Division of the U.S. Chemical Corps. 
There are 21 test ranges at the proving ground. Numerous chemical munitions 
and microorganisms were tested during the 1940s and 1950s. Large-scale con- 
ventional munitions testing was also conducted at the ranges until the late 1970s. 
Historical waste disposal practices have generated possible contamination at 205 
Solid Waste Management Units (SWMUs) and at an additional 41 Hazardous 
Waste Management Units (HWMUs) that ceased operation after 1980. From a 
regulatory perspective, contaminants of concern are agents (HD, L, VX, GB, BZ, 
GD), agent breakdown products, caustics, solvents, metals, volatiles, pesticides, 
PCBs, and POLs. 

Many sites located in the test ranges are being investigated by the Installation 
Restoration Program. The large volume of data being generated for these projects 
by various engineering consultants and other contractors lends itself to the use of 
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GIS software to manage the data. GIS provides the means to store, display, and 
analyze information from multiple diverse sources in one, two, and three dimen- 
sions. Effective data management is critical given the scale and complexity of the 
DPG environmental investigations. Although large amounts of data have been 
generated, much of it had resided in separate locations. Making a common data- 
base of chemical sampling results was the first step toward creating the GIS. A 
common geospatial database was also created, bringing together various vector 
datalayers and raster imagery. A customized, easy-to-use graphical interface 
was then written to access and analyze these data. There is a Windows desktop 
version as well as an Internet-accessible version that runs in a Web browser. 
Project managers can now use the GIS software via either platform to compare 
and analyze datasets of diverse types, e.g., orthophotos, contaminant information 
stored in a database, and geospatial datalayers such as sample locations, roads, 
and buildings. Powerful chemical query capabilities allow any user to search for 
analytical results either basewide or at a particular SWMU or HWMU. Project 
managers can query one or multiple contaminants by a specific detection thresh- 
old level, or return all sample results regardless of detection level. A typical 
query might involve searching for selenium samples taken anywhere on DPG 
that yielded a result greater than 100 ng/L. Query results can then be mapped to 
the screen to highlight clusters and/or possible contamination trends, or sent out 
to a spreadsheet program. Hard-copy maps can also be printed. 

The Installation Restoration Program GIS also protects current and future 
data investments. By making these data available to contractors prior to their 
undertaking new projects, there exists a significant potential to reduce redxin- 
dancy in data acquisition. 

Scott Reed, Installation Restoration Program Manager at DPG, states 
emphatically, "The GIS developed by ERDC saves me time and makes my 
operations more efficient. A contaminant sample query that had previously taken 
several calls to different contractors and several days in execution time now 
takes, in most cases, under a minute. We are extremely pleased with the Corps' 
GIS software product." 

This state of the art Geographic Information System software for accessing, 
displaying, and analyzing DPG installation restoration data was developed by the 
Remote Sensing/GIS Center at ERDC-CRREL using object technologies from 
commercial GIS and Database vendors. 
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2        INSTALLING DPG-GIS SOFTWARE FOR THE FIRST TIME 

Overview 

This section describes the procedure for a stand-alone installation of 
the DPG-GIS software on a Windows operating system. 

What do you need before you start? 

• DPG-GIS Version 2.0 Installation CD 

• This guide 

System requirements 

DPG-GIS is distributed on ISO9660 format CD-ROMs. DPG-GIS 
software may not be copied or distributed without express written 
permission. 

Microsoft Windows—Recommended 

• Windows 98, NT, 2000, XP 

• Pentium II 450-mhz processor, or greater 

• CD-ROM drive 

• 3.7 GB of free hard disk space, plus space for user reports 

• 128 MB of RAM, or greater 

Installing the DPG-GIS software 

In order for the DPG-GIS software to run properly, Microsoft Data- 
base Access Objects (DAO) software must be installed. When this manual 
was written, the current version of DAO was version 3.5. A copy of the 
DAO installation program is included on the DPG-GIS installation disk. 

To install or update the existing DAO software on your machine, 
perform the following steps: 

1. Insert the DPG-GIS software CD into your CD-Rom drive. 

2. Navigate to the Start menu and click Run. The run dialog box 
opens. 
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3.   In the Open text box type 

D:\miscellaneous\ DA035.EXE 

where D:\ is the letter of the default CD-ROM drive. You can also 
locate DA035.EXE via the Browse button. 

The install shield wizard will then direct you through the rest of the 
installation process. 

To install the DPG-GIS software using the Install Wizard, 
perform the following steps: 

1. Insert the DPG-GIS software CD into your CD-ROM drive. 

If Autorun has been enabled for your CD-Rom drive, the install 
wizard starts automatically. 

2. If the install wizard does not start automatically, click Run on the 
Start menu. The run dialog box opens. 

In the Open text box, type 

D:\setup.exe 

where D: is the letter of the default CD-ROM drive. You can also 
locate setup.exe via the Browse button. 

The install wizard will display a progress monitor and gives you the 
following options: 

• OK—Proceed to the next step. 

• Exit Setup—Discontinue setup and Exit. 

Duqway GIS Setup il 
Welcome to the Dugway GIS installation program. 

Setup coinot hstal system Files or update shared ftes iF they are in use. 
BeFore proceedng, we recommend that you dose any appications you may 
be running. 

OK EjdtSetHJ 

3.   To proceed to the next step, click OK. 



Dugway Proving Ground Installation Restoration Program GIS 

Assigning a destination folder 

1. Select the destination folder for the DPG-GIS software. 

The default drive location should be 
C:\Prograin FiIes\DugwayGIS\. 

2. If you wish to install in a different directory, click the Chaoge 
Directory button and enter a new location. 

3. After you are finished, click the Computer icon to install to the 
specified location. 

I Dugway GIS Setup 

ir    Begin the installation by clicking the button below. 

Ctckthis button to install Dugway GIS software to the specfied destination 
directory. 

■Directory:  

C:\Prog'am Files\DugwayGI5\ Change Directory 

Exit Setup 

Ctioosing a program group 

In this dialog box, you are prompted to choose a program group to add 
to the Start menu. The default Group is Dugway Proving Grounds GIS. 

1.   Click Continue to finish. 
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S Dugway GIS - Choose Program GrpuftJll 

Setup will add items to the group shown in the Program Group box. 
You can enter a new group name or select one from the Existing 
Groups list, 

2^ 

Program Group; 

lalUUIsllLlWB^ 

Existing Groups: 

Accessories 
Dell Accessories 

ESRI 
Startup 

Continue ] Caned 

A Progress box appears and indicates the status of the installation 
process until complete. 

Installing the data 

In order for the program to run properly, the Chemical, GIS, and 
imagery databases must be transferred to the install directory from the 
installation disk. 

1. Insert the DPG-GIS installation disk into the CD-ROM drive. 

2. Go to the Start menu and open Microsoft Windows Explorer 
(found under the Program-Accessories menu). 

3. In Windows Explorer navigate to the CD-ROM drive and copy the 
following data folders from the disk: 

• SdModel 

• Data 

• Images 

• Mocovers 
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4. Paste the folders into the C:\Prograni Files\DugwayGIS Directory. 

5. Remove the DPG-GIS software CD and insert the next imagery 
CD into the drive. 

6. Copy all of the imagery files on the disk to the images folder 
located in the C:\Program Files\DugwayGlS directory. 

7. When finished with the second CD repeat step 6 for any remaining 
imagery CDs delivered with the installation CD. 

Installation of the DPG-GIS software is complete. 

NOTE: You must restart your computer before the changes take place. 
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STARTING DPG-GIS 

1. Click the Start button on the taskbar. 

2. Point to Programs to display the Programs menu. 

3. Point to Dugway GIS. 

4. Click Dugway GIS 2.0. 

5. Click Start. 

iS'jU.>M> ''■'■■:       ■ •' 

I^IQ^' MMfeMtjfdlMi 

@ Jukbt' .  ■" ■■■■■'   * 

pi***.   ::" 
Bflij .AM ttlK*. DMIMM'. 

S^tiiU .■.   ■ ,.•." ;»j 

BgHJlHIi 
H-r3 KOI**         > 

H^ »<w       • 
Hoij >«,         f 
1 <9'<<*' 
l- ^ ""•■,_ 
1   ^ IM^xm':.. 

»"?•. 

1 F 

Dugway Proving Ground 
Installation Restoration Program GIS 

Ver 2.0 

Figure 1. Startup splash screen. 
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Installation Restoration Program GIS 

|Ffe-'"Tbdls >te|i 

-1D<X( 

Figure 2. Map View window. This window is displayed when DPG-GIS ini- 
tializes and the main application window opens. The yellow dots represent 
{Monument locations overlaid on a high-resolution orthophoto image. Along 
the bottom of the map window a map scale is displayed along with geo- 
spatial data projection Information and geographic coordinates location of 
the specific mouse location within the window. 
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DPG-GIS MAIN MENU AND CONTROL BUTTONS 

'He   Tools   Help 

i@i>|eir^|a|«|aKI 

Figure 3. Main program tasl(bar. This taskbar includes pulldown menus and 
specific task-oriented icons. 

>   In order to view the options available on the taskbar, hold the mouse 
pointer directly over each menu or icon for a brief description. 

File Menu 

Print (Ctrl+P)—^Allows the user to print information directly from the screen 
to a locally installed printer device. 

Exit—Exit the DPG-GIS program. 

Tools Menu 

Send Map to Clipboard—^Allows the user to copy the information displayed 
on the Map View window and send it to the clipboard to be pasted into a Word 
document. 

Database Query—Opens the main Database Query window. 

Layer Control—Opens the Layer Control window. 

lAP Viewer—Opens the Installation Action Plan (lAP) Viewer. Also 
available from the Management Unit Database Query window. 

Building Locator—Opens the Search by Building Interface (see Figure 11). 

3D Model Viewer—Opens the 3D Model Viewer. 

Help Menu 

Database Interpretation—^A submenu that provides specific information 
about database-related parameters and updates. 

Submenu Headings 

Analyte Groupings—Subjective analyte groupings provided by Parson's 
Engineering. 
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UTL for Metals in Soils—Upper tolerance level for metals in 
Background. 

Attemiation Parameters—^Analytical parameters for weighting and 
screening. 

Database Date—Date last update occurred. 

About Dugway GIS—Describes the relevant software information. 

I Took 

Send Map to C^board 

Rie 

Print Ctrl+P 

Exit 

Database Query 

Layer Control 

lAP Viewer 

Building Locator 

3D Model Viewer 

iHelp 

'    Database Interpretation   > 

'    Aboi* Dugway GlS... 

Figure 4. Pulldown menus available from the main taskbar. (See also Figure 
3.) 

Taskbar icons 

Located directly below the file menu is a series of taskbar icons (see Figures 
3 and 5). These taskbar icons perform some of the same tasks as the file menu but 
also provide additional functionality. 

Zoom in: Zoom to a particular object in the Map View window. 

n Zoom out: Zoom out in the Map View window. 

Pan: Reposition the Map View window to an area of interest. 

m 
Zoom to fill! extent: Reposition the Map View window to its full 
extent. 
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Building Locator: Call the Building Locator Display. 

!Q Well Database Query: Call forward the Well Database Query 
window. 

,■:■■; a 

Layer control: Call forward the Layer Control window. 

Taskbar, 
Controls 

sssa ilGlifl 
n> Tgds nB«p 

■m®>^ ml 
^^mmmmmm^masm 

Samtsa^  |K1,tn).9»y7;S34^SWaPm!%Ntl»3 

 :?•.?'«■» 
MoiMinunt Ucatioi | SBm|il«Qu«fyi Andy1»0u«ry| Wnt] Screanint ' 

<f MMmtmw r cowtCww WTO- 
r syiMj r,<<»««<«»««<»     ;.—— 

DfO_00f 

~3. Dft5 003 

Ucalc   I      Map    I     Clear    ! 

X 

Database Query 
Window 

.lOlxJ 
aaUMv] Inset Ua] PXnet 

r flia*«*(KW«ahe 

r Ro*fcf*ii   r s<»«* 
r siiotfis     r Biifcari 

r* 6«ii<ia> 

r w«tev* 

.Rwty I .. M!9gid,, If^iiwtui 

Layer Control 
Window 

Figure 5. Overview of the DPG-GIS layout with Layer Control and Manage- 
ment Unit Database Query windows activated. 
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LAYER CONTROL WINDOW 

Basemap Options 

This tab allows the user to turn on various layers of interest through the 
use of check boxes. These layers are exhibited as infrastructure (i.e., roads, 
buildings, and investigation areas) as well as environmental layers such as 
geology and vegetation. 

Image Options 

This tab allows the user to enable various layers of image data to be turned 
on and off. These layers are broken into three distinct sections: 1) Basewide 
imagery (i.e., Landsat images. Digital Raster Graphics [DRGs]), 2) Detailed 
SWMU site Ortho's 2002, and 3) 1998 Higgenbotham Aerial photography over 
specific site locations. 

Site Options 

This tab allows the user to enable layers that are specific to each particular 
monument location. These layers include line and polygon features as well as 
detailed road layers. 

Plume Options 

This tab allows the user to enable various contamination concentrations that 
may be available for a particular monument location. 
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Plume BaseMapl im^BJ Site 

Infrastiuctwe  
f- Bosds-ortho-centeiliie   

r BuSdhgs F BUMrig ITs 
f" IriVeEJigaiiotiAieas 
r Targets aid taikfe 
f Land Use       T'Orthosiid 

MM 

' ErMiorenenlal -— 

nConloiisSOOft 

Legend Dismiss 

Layer Control Tabs 

Legend 
Button 

i* Legend 

Refresh 

W OLD ROADS 

F MONUMENT LOCATIONS 
o 

r^WELL^SAMPLE LOCATION 
o 

F BOUNDARY 

Figure 6. Layer Control and Legend windows. 
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6 MANAGEMENT UNIT DATABASE QUERY WINDOW 

The Management Unit Database Query window allows the user to extract 
specific information for particular monimient locations, sample types, analytes, 
and specific well information. 

Monument Location tab 

The Monument Location tab builds information in the Map View window 
according to user-defmed selections about particular monument sites. 

Management Units 

Monument 
Location 

i* Management Unit Datdjase Quefy tW 
Monument Location | Sample Query) lAnaiyte Query) Well Screening Data j 

DPOJKJl 

DPG.OOt 
DP©_002 
DPG_003 
DPO_004 

r-Management UnKs ■ 
I <f AIMoflun»Pis 

I r S/VMU 
\ r HWMU 

Locate 

C (Ux^seri Order 
C Correctfve Actton 
r Complete ;NFA 

IAP2a02 

lAP PholQ 

Map Clear 

Lo^jtg. 

lAP 
li tfomiation 

Figure 7. Monument Location tab overview. 

Management Units (radio buttons) 

The Management Unit section allows the user to narrow the type of monu- 
ment location search by specific criteria. These criteria are All Monuments, 
SWMU, HWMU, Consent Order, Corrective Action, and Complete/NFA. 

Locate (button) 

By highlighting the monument location of interest and depressing the Locate 
button, the Map View window shows a zoomed-in view of the Monument site 
(yellow dots) along with the corresponding well locations (green dots) associated 
with the locality. 



16 ERDC/CRREL SR-03-1 

lAP Information (buttons) 

lAP Information for a selected monument site can be displayed by depressing 
one of the lAP buttons along the left side of the dialog box. By depressing the 
lAP 2002 button the lAP viewer is displayed along with any lAP information for 
the given monument location. By depressing the lAP Photo button all available 
photographs for the location are displayed. 

Sample Query tab 

The Sample Query tab allows the user to obtain detailed geographic and 
chemical information about a particular well located at a chosen monument site. 

Display 
Options 

Well _ 
Information 

Query 
Results 

i^ Management Umt DatabSf e Q leciF 

Monument Location LiampleQuarx| Analyte Query | Well j Screening Data] 
-Dtspfay:- —^- APGOOIEPOOI Geographic 

Information 

Figure 8. Sample Query tab overview. 

Well Information 

The Well Information vidndow displays the well identification numbers 
(LOCID) that are associated with a chosen monument location. 

Display Options (radio buttons) 

The Display Options let the user query all information acquired for a 
particular well or only where there has been information detected about a 
particular analyte. 
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Query Results 

This window displays the query results for each individual well that has been 
selected for a particular monument. 

Geographic Information 

The geographic information such as Coordinates, Location ID, and Elevation 
are displayed about a particular well. 

Option Buttons 

Certain options can be selected here, e.g., the Map button, which highlights 
the well of interest in the Map View window or sends the query results to the 
clipboard to be pasted into a spreadsheet. 

Analyte Query tab 

The Analyte Query tab allows the user to search for locations based on a 
particular or set of analytes, matrix, type, and detection level. 

Analytes- 

Display 
Options 

Matrix 
Types 

ig* Management llntt Database Query 

Monument Location j Sample Quer 
S«tirc^91 Aralyte(s) 

1,1,1.2-TETRACHLcT] 

r |-,'.,t,.-'-TcT ^H,.J 

Dtepkty:- 

iKi:- JEJiU 
Analyte Quenfi V 'el! ] Screening Data j 

■ Matrix: - Scope: ■ 
C M ResiJts f» Detects only' <• Any   I <* Basewicie -7- 

C iMSter' C Jiionumert   ! 
C Display Above:    jg~ 

r Sol 

a^^j^ \.f.'<'. I'i C.iii.i Run Queiy  j 

Query Display 

Scope 
Options 

Run 
-Query 

Button 

Figure 9. Analyte Query tab overview. 

Analytes 

The Analytes selection box allows the user to select up to three analytes to 
search for through the use of puUdovm menus and radio buttons. 
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Display Options 

The Display Options section allows the user to select the type of analyte 
resuhs of interest to the user. These include all results, detects only, and a user- 
defined detection level above which the results will be displayed. 

Matrix Types 

The Matrix Type section allows the user to further narrow the query results 
by narrowing the type of sampling matrix. The options are any, water, and soil. 

Scope Options 

The Scope Options section allows the user to select data from the entire base 
or to narrow the results to a particular monument location. 

Run Query Button 

Activates the users query. 

Well Information tab 

The Well Information tab enables a search for any additional well 
information that may reside in the database regarding monitoring wells. 

Selection 
Menu 

i* Management Unit Database Query* «|§i;j;*i' -iDlxl: 

Monument Location 1 Sample Query j Analyte Query [,Wel!J| Screening Data 

002-MiM)1 

002-l*WI 
002-MM32 
002-1*^3 
002-MM)4 

This tafci enables a search for addSlonal ln<ormSlon 
Biat mayfesicte inihe database rega-ding 
MONITOIRING V^«LLS only... 

Query Results 

Figure 10. Well Information tab overview. 
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Selection Menu 

The Selection Menu houses all the monitormg well numbers. By selecting a 
particular monitoring well from the pulldown menu, the results for that particular 
well will be displayed in the Query Results window. 

Screening Data tab 

The Screening Data tab enables a search for information related directly to 
screening data such as soil gas, hydropunch, and TNT. These data are not con- 
sidered definitive-level data. 

Selection 
Menu 

Sample 
Type 

Display 
Options 

I* Management Unit Database Cucnrs 

1,1,1.2-TETRACHLC 3 

iJBiiiJ 
hdonument Location \ Sample buBry ] Analyte Qu iry] Well LSg„e.e.ni.na.Qak-| 

San^Type:   - Cfepiay:    -   -- rScope:    j 
(f AH C All Results = (• Basewide I 
r SoHGss       (• Detects only     ! C Monument •'^ 
r Hydropunch «~ Disptey Above; G j:ir-G 00'  j\\ Hyi^opunch, Solt Gas, and 

TNT data. These are NOT 
DffNTlVE level data. 

T 
Clear 

Query Results 

lUmCluefy 

-Scope 
Options 

Selection Menu 

The Analyte Selection box allows the user to select an analyte to search for 
using the pulldown menu. 

Sample Type 

The Sample Type section allows the user to further narrow the query results 
by narrowing the type of sample. The options are soil gas, hydropunch, and all. 

Display Options 

The Display Options section allows the user to select the type of analyte 
results the user is interested in displaying. These include all results, detects only, 
and a user-defined detection level above which the results will be displayed. 
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Scope Options 

The Scope Options section allows the user to select data from the entire base 
or to narrow the results to a particular monument location (SWMU or HWMU). 
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BUILDING LOCATOR WINDOW 

Locate Building 

The Locate Building dialog box is located under the Tools pulldown menu 
from the taskbar and toolbar. This option allows the user to zoom to a particular 
building in the Map View window by selecting a building number of the user's 
interest. (NOTE: The buildings option must be selected in the basemap layers 
control menu in order to operate correctly.) 

BiiUng Nuntben 

Selection 
Menu ~ 

S 10 
1(M Close 
imi 
10)2 z} 

■ De$c(iption: 

oidOescript.     Descrtption 
Window 

OldBldglt: 

Figure 11. Building Locator window. 
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APPENDIX A. EXERCISES AND EXAMPLES 

EXERCISE 1 

Viewing a Specific Monument Location 

For this and the remaining exercises, unless noted otherwise, Monument 
Location DPG_003 will be used. 

1.   In the Monument Location tab of the query dialog box, check the 
management unit type desired (i.e., SWMU, HWMU, Corrective, etc.). 
Use SWMU for this exercise. 
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2.   Select the Monument Location of interest (DPG_003). 
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3.   Click the Locate button. 

iSffl^HK! '•"' "M 
DPGJMl, ore, and003 have been tontHned 

oc      I 

After clicking the Locate button, if the Momiment Location you have 
chosen has recently been combined with any other Monument Locations 
as defmed by the most recent lAP, a warning screen will inform you 
which locations have been combined. 

-ii" '■ 

:'\ ocatiori • ;• -  ^     ••>     ■.' \: 
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r MONUMENT LOCATOR 
D 
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S? MRSIDCAT (Image) 

The Map View window changes to show you the desired monument 
location (yellow) at a more appropriate scale. Included in the Map View 
window are all monitoring well locations (green). Other layer options can 
be toggled on or off from the Layers window, including the removal of the 
background image and the Legend window (right). 

NOTE: Layers cannot be toggled on or off from the Legend window. Use 
the Refresh button on the Legend window to update the legend as layers are 
added and removed. 

The Monument Location tab is also used to view the Installation Action 
Plan (lAP) information for particular Monument Locations. 



24 ERDC/CRREL SR-03-1 

4. Click the lAP 2002 button to view the available photos associated with 
the Monument Location and the lAP. 

5. Click the lAP Photo button. 
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EXERCISE 2 

Performing a sample query 

Select Monument Location DPG_003 using the same steps outlined in 
Exercise 1. 

1. Activate the Sample Query tab. 

2. Check the appropriate display checkbox: All Results or Detects Only. 
For this exercise, check the box next to Detects Only {i.e., only 
chemicals that have been detected will be displayed in the Query 
window). 
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3. Choose a well of interest from the left-hand pulldown menu of LOCIDs 
(use APG003EP006). A specific LOCID for a particular well can be 
determined by dragging the mouse cursor over a green well location in 
the Map View window. The LOCID vnll then be displayed on screen. 

Immediately following step 3 the query is activated and the results are 
displayed at tlie bottom in the Ouer>' Display window. Geospafial infor- 
mation regarding the well location is displayed along the right-hand side 
of the window while the number of detection results are given directly 
above the Queiy Results window. 

4. Click the Map button. The well location in the Map View window that 
corresponds to the LOCID in the left-hand column will flash and turn 
from green to red. (NOTE: To remove the highlighted well location from 
red back to green in the Map View window, depress the Clear button on 
the Display Options panel.) 
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Querying a well location from the Map View window 

It is also possible to query information about a specific well location by 
selecting it from the Map View window. 

>   Follow the instructions outlined in Exercise 1 for selecting a Monument 
Location. 

1. Depress the Well Database button on the toolbar. 

2. Make sure the Sample Query tab is active. 

3. Use the mouse cursor to select a green well sample location from the 
Map View window. 
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Once the well location has been selected from the Map View window, the 
results are automatically transferred to the Query Results window. 

How to save your query results to a report format 

In order to save the results from this and other queries to a report format, you 
will need to follow the steps outlined below. 

1. Depress the Send to Clipboard button. (Once the Clipboard button has 
been depressed, the query results have been copied to the clipboard so 
they can be pasted into a spreadsheet document.) 

2. Open a spreadsheet utility (e.g., Microsoft Excel). 

3. Navigate to the Edit menu in Excel and click on Paste. 
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Once you have followed these steps, your results should look like the image 
above, with each coluiiiii being separate. While similar results are achieved when 
using a document reader such as Microsoft Word, this method results in a tab- 
delimited format. Therefore, it is much easier to use Microsoft Excel to table the 
data and then insert the resulting table into your Word document. 

EXERCISE 3 

Executing an analyte query 

An analyte query allows the user to search the entire monument location 
database for a particular type of analyte or combinations of up to three different 
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analytes. The results provide the user with the LOCID, date, and other relevant 
chemical testing information for each site. 

1. Select the Analyte Query tab, click the checkbox to the left of the 
pulldown menu, and choose the STRONTIUM analyte from the 
scrolling list of analytes. 

2. In the Display section, choose the type of results you want to be 
displayed. 

All results: Display all types of results, regardless of the testing outcome. 

Detects only: Display only results where detection for a particular analyte 
has been achieved. 

Display above: A user-defmed "base" value, which then displays results 
only above the entered value. 

>   For this exercise, check the Detects Only box. 
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3. Choose the matrix type desired under the matrix section: 

Any: All types of matrix. 

Water: Water-only matrix. 

Soil: Soil-only matrix. 

>   For this exercise, check the Any box. 

4. Choose the area of the search in the scope section: 
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Basewide: Search all locations at DPG. 

Monument: Search a particular monument location. 

>   For this exercise, check the Basewide box. 

5.   Click the Run Query button. 
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After completing step 5 and e.Keciiting the query, the infomiation retrieved 
from the database is displayed in the Query Results window. The number of 
results for the queried analyte is displayed directly above the Queiy Results 
window. 

EXERCISE 4 

Executing a MultiplelThreshold Analyte Query 

This exercise illustrates how the user can perform a query for up to three 
different analytes using the Analyte Query tab. Furthermore, it also instructs 
users how to refine their results by defining a threshold. 

1. Click the top radio button to the left of the pulldown menu and choose 
the DINOSEB analyte from the scrolling pulldown hst of analytes. 

2. Chck the second analyte radio button and select 1,1 -Dichloroethene from 
the scrolling analyte hst. 

3. Click the third analyte radio button and select 1,1,1,2-Tetrachloroethane 
from the scrolling analyte list. 
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# 

K^ Management Unit Database Query 

Monument Lxjcatlon | Sample Query   . ^alyte Query | V fell I Screening Data 
Searching 3 firiyte{s) 

CUNO^B 

1.1-OICHLOROETre 

<!■ jl,1,1,2-TETRACHLCjrJ 

Oi^ay; 

^?-' laiiH 

- Matrix: - Scojse; . 

(* Basewide J*- rABResias*? Delectsorty' <* Any 
__   ,    .. ,    r Water   T iwonunert 
ro^ayAbove:   jg ^^    , ^.,^; j 

■Mart I    Clear!  a-.--!Tf.-ri,,!,-,-.■.;)      Run Query 

T 

4. In the Display section, choose the Detects Only button. 

5. Choose the matrix type desired under the matrix section. 

Check Any for this exercise. 

6. Choose the area of the search in the Scope section: 

Basewide: Search all locations at DPG. 

Monument: Search a particular monument location. 

>   For this exercise, check the Basewide box. 

7. Chck the Run Query button. 
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After completing step 7 the query results for all three chemicals are displayed 
in the Query Results window with the total number of analytes detected (235 
results). 

To further refine the results of your query the Display Above option can be 
used to define a base threshold value for detection results. 

In this example, we would like to display only the results that are above a 
detection value of 1000. 

1. Click the Display Above button in Display options. 

2. Enter a value of 1000. 

3. Click the Run Query button. 

ij* Management Uivit DatsbiKe Query 

Monument Locaiionl Sat iple Query   ViMialyts 3usry|Well| Screening Data j 
;".'     SeatcHng 3 Attfii^i)   r Xsptey: ——~^—      -- -Mtirix-    .Scope- 

r— — -^ \ « ni«^,«K™..^    r     *^ "**"' ^ Monument 

W^i?: ■M>^ 

'<!-[l,1,i;2-TETRACHLCj^ ~ 
d 

Map  I    Clear I SmdToC»pboartl| |Cr3ffiiiafiJBB;~": 

Refined 
Results 

4Rg«ul<»fl>f aMOSEB, OCHI. TC11128ii»eiWKle 
Lodd I Pate l<n»WB «rai»i)te<lonn) PwVO Vrtue UnK« Mitfte BenPepth BnaOatiWi EPA Campiiw 
CRRO61MWM «i Ofliffotjocen rIAM 

rJAlT 
l.l-DiCHLOSOETHEME 1C30 U»IL IVVO 40 40 PARS 

CRR061MW1A101 MOdOCei 1 1.1-DICHLOR0emEM6 1630 UO(L "WO 40 40 PARS 

CRRCK1 MV<01 AHpn 2/20qDCE11 1,1-aCHL0R0eTHE(C 1010 UGiL tvw 40 40 PARS 

CRR061MW31 All Ofl 2/20dOCE11 1,1-OICHLOROETHENE IWO UO(L V» 40 40 PARS 

The results of using the Display Above option are displayed in the Query- 
Results window. The number of quei7 results is significantly reduced fi'om an 
initial 235 to a more refined number of four. 

Displaying query results as locations in the Map View window 

It's possible to display the location of the query results in the Map View 
window by utilizing the Map button. 

1.   Make sure the Map View window is at full extent by depressing the 
Zoom to Full Extent button on the toolbar. 
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2. Click the Clear button in the Query window to make sure any previous 
map results are removed from the Map View window. 

3. Click the Map button. 
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The results of using the Map button will display the queried sample locations 
in red across the Map View window. Zoom into a red sample location result to 
see this more clearly. 
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EXERCISE 5 

Adjusting layers and copying ttie Map View window for printing 

1. From the Monument Location tab, select the DPG_079 monument 
location. 

2. Click the Locate button. 

3. From the Layers window select the Image tab and check the SWMU 79 
checkbox from the detailed SWMU ortho's 2001 section. 

4. Click the Legend button. (If the Legend box is open, chck the Refresh 
button.) 
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Once you have followed steps 1 tlirough 4 a zoomed-in image of DPG_079 
should be seen in the Map View window. Although the monument and well 
locations have been covered by the ortlio photography image, this problem is 
easily fi.xed by using the Legend window to adjust the positioning of the layers. 
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By using the Legend window, the image covering the monument locations 
can easily be adjusted by using the mouse cursor to drag the layer below the 
Well/Sample Location layer, as seen above. 

Printing the Map View window 

This section provides insight into printing and pasting the Map View 
window into other programs for printing and report generation purposes. 

From the File menu on the toolbar, you can select the Print option to print 
directly to a local installed printer. 

NOTE: mis IS NOT RECOMMENDED FOR PRINTING COLOR IMPS! 

To print color versions of the Map View window, use the Send Map to 
Clipboard option in the Tools menu. 

1.   After generating the map you would like to print or use for a report, 
select the Send Map to Clipboard option from the Tools menu on the 
toolbar. 
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2. Open Microsoft Word or similar word processor. 

3. From the Edit menu choose Paste. 
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After pasting the image into Microsoft Word, it is easy to draw borders, 
center, scale, add arrows, etc., to higliligiit the features of interest. 


